
































What is Google? 

Google is a popular internet search engine. It scans the Web to find Web pages that 

are relevant to the words you have typed in the search box. 

Google was founded on September, 1998, by American computer scientists Larry 

Page and Sergey Brin while they were PhD students at Stanford University in California.  

 

What is Google Search? 

Google search is the most popular search engine worldwide, enabling users to quickly find 

information on the internet. With its advanced algorithms, Google organizes and indexes 

billions of web pages to deliver relevant search results. What sets Google search apart is its 

ability to understand user intent and provide accurate answers to queries, ranging from 

simple facts to complex research topics. This helps individuals save time and easily access a 

wealth of knowledge. 

Additionally, Google search continuously evolves, integrating features like instant answers, 

auto-complete, and personalized suggestions, enhancing user experience and making 

information retrieval more efficient, allowing for fast browsing. 

The Importance of Google Search in Daily Life 

• Provides instant access to vast amounts of information at our fingertips. 

• Enables quick and efficient research on various topics, from health issues to DIY 

projects. 

• Helps in resolving everyday queries, such as finding recipes, checking weather 

forecasts, or locating nearby businesses. 

• Facilitates learning through educational resources, tutorials, and instructional 

videos. 

• Saves time by offering auto-complete and suggested search terms. 

• Keeps users updated with the latest news, trends, and developments across various 

industries. 

• Acts as a valuable tool for making informed decisions, whether it's buying products, 

planning trips, or comparing prices. 
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https://aicontentfy.com/en/blog/save-time-and-effort-with-best-paraphrasing-tools-online
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Google	
  Drive	
  is	
  an	
  online	
  repository	
  storage	
  facility	
  for	
  you.	
  	
  Drive	
  provides	
  you	
  with	
  
30GB	
  of	
  storage	
  for	
  any	
  file—pictures,	
  documents,	
  etc.	
  	
  Your	
  files	
  can	
  be	
  reached	
  from	
  
any	
  smartphone,	
  tablet,	
  or	
  computer.	
  	
  So	
  wherever	
  you	
  go,	
  your	
  file	
  follows.	
  	
  You	
  can	
  
share	
  your	
  files	
  or	
  folders	
  with	
  anyone,	
  without	
  having	
  to	
  email.	
  
	
  
Sign	
  into	
  your	
  account	
  at:	
  
	
  
http://drive.google.com	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  

Getting	
  to	
  know	
  the	
  layout	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  



Creating	
  a	
  Document	
  
	
  
	
  
Click	
  on	
  the	
  red	
  “CREATE”	
  button	
  and	
  choose	
  “Document”	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
Now,	
  you	
  have	
  an	
  untitled	
  document.	
  	
  You	
  should	
  first	
  click	
  “untitled	
  document”	
  to	
  
rename	
  it	
  and	
  then	
  you	
  can	
  click	
  on	
  the	
  document	
  to	
  start	
  typing.	
  	
  You	
  are	
  familiar	
  
with	
  the	
  formatting	
  options	
  because	
  they	
  are	
  similar	
  features	
  offered	
  in	
  Microsoft	
  
Word.	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  



	
  

Creating	
  Spreadsheet	
  &	
  Presentation	
  
	
  
Click	
  on	
  the	
  red	
  “CREATE”	
  button	
  and	
  choose	
  “Presentation”	
  or	
  
“Spreadsheet”	
  
	
  
These	
  documents	
  are	
  equivalent	
  to	
  creating	
  a	
  Microsoft	
  PowerPoint	
  
and	
  a	
  Microsoft	
  Excel	
  document.	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
Rename	
  each	
  of	
  your	
  documents	
  first	
  so	
  it	
  can	
  be	
  easily	
  located	
  in	
  drive	
  and	
  then	
  
you	
  will	
  notice	
  a	
  familiar	
  menu	
  bar	
  and	
  tool	
  bar,	
  similar	
  to	
  Excel	
  and	
  PowerPoint.	
  
Just	
  click	
  into	
  the	
  document	
  area	
  to	
  begin	
  typing	
  and	
  working.	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  



	
  
	
  

Creating	
  a	
  Form	
  
	
  
Click	
  on	
  the	
  red	
  “CREATE”	
  button	
  and	
  choose	
  “Form”	
  
	
  
	
  
This	
  is	
  used	
  to	
  create	
  questionnaires	
  or	
  surveys.	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  

Once	
  you	
  create	
  your	
  questionnaire,	
  you	
  
can	
  have	
  it	
  published	
  for	
  completion	
  and	
  
then	
  you	
  response	
  can	
  be	
  analyzed	
  by	
  
checking	
  out	
  the	
  summary.	
  

	
  
	
  
	
  
	
  
	
  
	
  



Creating	
  Folders	
  	
  
Organizing	
  Documents	
  
	
  
Click	
  on	
  the	
  red	
  “CREATE”	
  button	
  and	
  choose	
  “Folder”.	
  
	
  
	
  
	
  
Name	
  your	
  Folder	
  and	
  then	
  you	
  will	
  see	
  it	
  	
  
beneath	
  “My	
  Drive”	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
You	
  may	
  drag	
  and	
  drop	
  files	
  into	
  your	
  folder	
  or	
  you	
  can	
  use	
  the	
  Red	
  upload	
  arrow	
  to	
  
upload	
  files	
  into	
  drive.	
  	
  Then	
  you	
  can	
  organize	
  them	
  into	
  folders.	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  



Sharing	
  Files	
  or	
  Folders	
  
With	
  people	
  who	
  have	
  a	
  Google	
  account.	
  
	
  
	
  
Open	
  or	
  create	
  a	
  new	
  document.	
  	
  	
  Then	
  click	
  on	
  the	
  “share”	
  button	
  on	
  the	
  top	
  right	
  
of	
  the	
  screen.	
  	
  A	
  new	
  dialogue	
  box	
  will	
  appear	
  and	
  you	
  will	
  want	
  to	
  input	
  the	
  
accounts	
  (email)	
  of	
  those	
  you	
  wish	
  to	
  share	
  this	
  document	
  with.	
  	
  Provide	
  them	
  with	
  
either	
  Edit,	
  Comment,	
  or	
  View	
  rights	
  and	
  they	
  can	
  now	
  access	
  this	
  file	
  from	
  their	
  
account	
  under	
  “Shared	
  with	
  me”.	
  
	
  

	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  



Sharing	
  Files	
  or	
  Folders	
  
With	
  people	
  who	
  DO	
  NOT	
  have	
  a	
  Google	
  account.	
  
	
  
	
  
If	
  are	
  trying	
  to	
  share	
  a	
  Google	
  Doc	
  with	
  someone	
  who	
  doesn’t	
  have	
  an	
  account,	
  you	
  
right	
  click	
  on	
  the	
  document,	
  select	
  share,	
  and	
  then	
  select	
  email	
  as	
  attachment.	
  
	
  

	
  
	
  
Fill	
  in	
  the	
  “Attach	
  as”	
  
and	
  the	
  email	
  address	
  
you	
  are	
  sending	
  it	
  to	
  
as	
  well	
  as	
  the	
  message	
  
and	
  then	
  click	
  send.	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  



This	
  is	
  how	
  it	
  looks	
  in	
  the	
  recipient’s	
  mailbox.	
  	
  They	
  have	
  the	
  option	
  to	
  either	
  view	
  
or	
  download	
  the	
  file.	
  	
  
	
  

	
  
	
  
	
  
Viewing	
  the	
  Document	
   	
   	
   Downloaded	
  and	
  opened	
  in	
  MS	
  Word	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  



Uploading	
  Files	
  	
  
	
  
Click	
  on	
  the	
  red	
  upload	
  arrow.	
  
Then	
  click	
  on	
  the	
  “Files…”	
  label.	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
Select	
  your	
  file	
  that	
  you	
  wish	
  uploaded.	
  	
  It	
  will	
  upload	
  and	
  appear	
  in	
  your	
  Drive.	
  
	
  

	
  
	
  
	
  
	
  
	
  



You	
  can	
  see	
  that	
  it	
  is	
  uploaded	
  as	
  a	
  word	
  document.	
  	
  You	
  can	
  view	
  it	
  by	
  clicking	
  on	
  it	
  
or	
  if	
  you	
  want	
  to	
  edit	
  it,	
  you	
  will	
  need	
  to	
  open	
  (and	
  convert)	
  to	
  a	
  Google	
  document.	
  
	
  
	
  
Being	
  Viewed	
  in	
  Google	
  Docs.	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
Right	
  Click	
  and	
  select	
  “Open	
  With”	
  to	
  edit	
  with	
  Google	
  Docs.	
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How to use Google Drive 

 
 

 

Google Drive is a free, web-based office suite and data storage service 

offered by Google.  It enables users to create online documents and edit 

them collaboratively.  As well as word processing, spreadsheets and 

presentations, Google Drive offers a “forms” option that can be used to 

generate online surveys, collate them and present the results.   

 

“Google Apps for Education” is a package of free online tools, including 

Google Drive compiled specifically for schools and colleges.  It allows schools 

to set up email accounts for its teachers and students, facilitates shared 

calendars, shared documents and even the creation of websites that can 

become class or project websites.  It gives the administrator control to limit 

access to emails and sites.   

 

If you are considering setting up Google Apps for your school it is advisable 

that it is done in consultation with the ICT Administrator in your school.   

 

For the purposes of using Google Drive with your students, regular Gmail 

accounts will suffice. 

 
 

 

 

 

 

 

 

 

Tip: 

Google Drive works best when using the Google Chrome browser.  If 

you don’t already have it installed on your laptop/PC, download it now 

from https://www.google.ie/.  This will allow you to install other 

Google Apps and access them from Google Drive in the future. 

https://www.google.ie/
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Step 1: Log into your email as normal 

 

 
 

 

 

Step 2: click on Drive at the top of the page.  
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Step 3: You are now into the Google Drive dashboard. 

 

 
 

 

 

Step 4: Creating a document from scratch is very simple. Click 

the create button.  
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Step 5: You can create a document (similar to Microsoft Word), 

spreadsheet (similar to Microsoft Excel), presentation (similar to 

Microsoft PowerPoint), form (useful for creating tests, 

evaluations, surveys), etc. 

 

 
 

Step 6: Select Document (the steps that follow also apply for 

creating a presentation or spreadsheet). 
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Step 7: To name the document click on Untitled document  

 
 

 

 

Step 8: Saving your document. 

There is no save button in Google Drive.  All changes made are  

automatically updated, so your work will never be lost.  
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Step 9: Once the document has been completed, it will be 

privately owned by you. If you want to share it with your students 

or other members of staff just click the “Share” button on the 

top right hand corner.  

 

 
 

 

Step 10:  

 
 

 

 

 

Simply click on “Change” and 

allow others to either view 

or edit the document 

(editing allows 

collaborative/co-operative 

work to take place)  

 

You can add people by 

entering their email address 

(this will be easier and 

quicker if you have their 

email addresses already 

saved in your email contacts) 

 

Click on “Share & save” when 

you’re finished 
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Step 11: You can also upload your existing word 

document/spreadsheets/PowerPoint Presentations that you have 

already created to Google Drive from your computer or laptop 

 

                    
 

 

Step 12: Select the file or folder you want to upload, then click 

on “Open” to attach it.  

 
 

 

 

Click on the 

upload icon 

and select 

either file or 

folder from 

the drop 

down menu, 

depending on 

what you 

want to 

upload 
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Step 13: 

 

 
 

 

 

 

 

 

Documents can be easily shared with students and/or worked on 

collaboratively.  Students can follow the same process to share 

their homework/projects which you as the teacher can then 

comment on. 

 

For more information, click 

https://www.google.com/intl/en/drive/start/features.html 

Click on the document and it will open 

https://www.google.com/intl/en/drive/start/features.html


Basics   of   Google   Docs   (Lesson   1   Handout) 
Google   Docs   gives   users   the   ability   to   create   and   store   documents   and   files   using   any   web   browser   (in 
“the   cloud”),   access   them   from   any   device,   and   give   multiple   people   simultaneous   access.   “The   Cloud” 
is   a   phrase   that   means   being   able   to   access   information   through   a   web   browser   that   are   stored   on   a 
company’s   computers.   This   gives   you   the   ability   to   access   them   anywhere   and   share   them   with   others. 
Heads-up:   Google   Docs   works   best   in   Google   Chrome,   but   you   can   usually   use   it   in   any   web   browser 
(Safari,   Internet   Explorer,   Firefox). 
 

To   get   started,   go   to   drive.google.com   and   log   in   to   a   Google   account 
OR   login   to   a   Gmail   account,   click   on   the   little   grid   in   the   upper-right   of   the 

screen   (looks   like   )   and   choose   ‘Drive’ 
Create   a   Google   Doc 

 

Once   you’re   in   your 
Google   Drive   account, 

click   on   the   ‘New’   button 
and   click   on   ‘Google   Docs’ 

to   create   a   new   Google 
Doc. 

 

To   change   the   name   of   the 
document,   click   on   the 

‘Untitled   document’   name 
in   the   upper-left   corner   of 
the   screen   and   replace   it. 
Press   ‘Enter’   or   click   in 
the   document   to   save. 

Your   document   is 
constantly   automatically 
saving   as   long   as   you   are 

connected   to   the   internet, 
and   it   will   tell   you   as 

much   if   you   look   to   the 
right   of   the   ‘Help’   menu. 
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Edit   a   Google   Doc 

 

 

To   insert   a   picture,   click   on   the 
‘Insert’   menu   and   select   ‘Image.’ 
You   can   upload   a   picture   from 
your   computer   or   click   on   the 

heading   that   says   ‘Search’   to   use 
a   Google   Image.   To   insert   a 

table,   click   on   the   ‘Insert’   menu, 
hover   over   the   ‘Table’   option, 

and   use   your   cursor   to   indicate 
the   dimensions   of   your   table. 

 
Download   a   Google   Doc 

 

To   download   your   document   as 
a   Microsoft   Word   document   or 
as   a   PDF,   click   the   ‘File’   menu 
and   hover   over   the   ‘Download 

As’   option.   Once   you   click   on   the 
desired   file   type,   your   computer 
will   either   download   it   to   your 
downloads   folder   or   it   will   ask 
you   where   you   want   to   save   it 
(depending   on   your   browser 

settings).   Once   you   download   it, 
you   can   open   it   in   another 
program   or   attach   it   to   an 

e-mail. 

   
Prepared   by   Andrew   BoddySpargo 



Share   a   Google   Doc 

 

Method   1   ­   send   invite 
To   share   a   Google   Doc,   locate 
the   blue   ‘Share’   button   in   the 

upper-right   corner   of   your 
browser   window   and   click   on   it. 

You   can   then   type   the   email 
address(es)   of   the   person(s)   you 

want   to   share   the   document 
with.   You   can   also   select   what 

TYPE   of   access   they   get   (change 
the   “Can   edit”   option)   and   type 
a   little   message   for   them.   Then 

you   can   click   ‘Send’   and   they 
will   get   an   email   with   an 
invitation   to   access   the 

document. 

 

IF   you   share   a   document   this 
way   with   an   email   address   that 
is   not   a   Google   account,   then 
you   will   get   this   warning.   The 

person   you   share   it   with   will   be 
able   to   view   it,   but   unless   they 
have   a   Google   Account,   they 

won’t   be   able   to   edit   it. 

 

Method   2   ­   use   a   link 
Instead   of   typing   the   e-mail 

addresses   of   specific   people,   you 
can   click   the   “Get   shareable 

link”   option   and   it   will   generate 
a   URL   that   you   can   copy   and 

paste   into   an   email   to   share   with 
others.   ANYONE   who   gets   that 
link   can   access   the   Google   Doc, 
so   be   careful   with   this   option. 

You   can   change   the   type   of 
access   associated   with   the   link 

by   clicking   the   down   arrow   next 
to   ‘can   edit’   in   the   picture   to   the 

left   and   choosing   a   different 
type   of   access.   Then   click   ‘Copy 
link’   and   paste   it   into   any   email. 
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Access   a   Google   Doc 

 

If   someone   sends   you   a   Google 
Doc   invitation,   this   is   what   the 
email   looks   like.   It   grants   only 
your   specific   Google   Account 

access   to   it.   Click   on   the   name   of 
the   document   or   the   blue   button 

that   says   “Open   in   Docs”   to 
access   the   document.   In   this 

example,   Andrew   has   given   me 
editing   access   to   the   document, 

so   I   can   make   changes. 

 

If   someone   sends   an   invitation 
to   access   a   Google   Doc   to   a 

non-Google   email   address,   this 
is   what   it   looks   like.   Because   the 

email   address   doesn’t   have   a 
Google   account,   it   grants   them 
access   to   view   it.   If   they   happen 

to   be   logged   into   a   Google 
account,   then   they   will   be   able 
to   edit   the   document   with   that 
Google   account,   even   though   it 

was   shared   with   the   non-Google 
address.   This   type   of   sharing   is 
slightly   less   secure   because   if 

the   invitation   is   forwarded   on   to 
someone   else,   then   they   could 
get   access,   too.   It’s   still   slightly 

more   secure   than   just 
generating   a   link,   though. 

 
If   someone   emails   you   a   link   to   their   Google   Doc,   then   generally   they   will   send   the 

whole   URL   in   the   body   of   an   email,   or   they   will   type   an   email   and   create   a    hyperlink 
using   some   of   the   email   text   to   link   to   the   Google   Doc   that   they’re   sharing   with   you. 

 

 
For   more   information,   search   “Google   Docs   Tutorials”   on   YouTube   or 
search   for   what   you   want   to   do   with   Google   Docs   using   a   search   engine 

   
Prepared   by   Andrew   BoddySpargo 
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LIBRARY AND LEARNING SERVICES STUDY GUIDE | GOOGLE DOCS 
www.2.eit.ac.nz/library/OnlineGuides/Google Docs.pdf 

 

 
 

Google Docs 
 
Opening a New Doc  
To open a new Google Doc, navigate to your Google Drive and click on New. 

 
Click on the arrow next to Google Docs 

 
 
 
 



LIBRARY AND LEARNING SERVICES STUDY GUIDE | GOOGLE DOCS 
www.2.eit.ac.nz/library/OnlineGuides/Google Docs.pdf 

 

 
 

 
Choose between whether you want a blank document or a template 

 
 
If you choose Template, it will bring up a list of templates that are designed for specific types of 
documents. Click on the one you wish to use. 

 
 
 
 
 
 
 
 
 
 



LIBRARY AND LEARNING SERVICES STUDY GUIDE | GOOGLE DOCS 
www.2.eit.ac.nz/library/OnlineGuides/Google Docs.pdf 

 

 
 

 
If you choose Blank, it will open up a document that looks like this. 

 
 
Customising your Document 
At the top of the document, there is a quick access toolbar with commonly-used tools such as size, 
bolding, alignment, font etc. 

 
 
There are also more tools and features that can be accessed from the menus located above the toolbar. 

 
 



LIBRARY AND LEARNING SERVICES STUDY GUIDE | GOOGLE DOCS 
www.2.eit.ac.nz/library/OnlineGuides/Google Docs.pdf 

 

 
 

Sharing and Accessing 
Sharing  
As Google Docs are stored in your Google Drive, you can share them with others so that they can access 
them. 
Click on the Share button 

 
 
From there, you can either enter the email addresses of those that you want to share the document 
with. 

 
Or you click on Get Shareable Link and copy a shareable link to send to them. You can also choose 
whether the people with the link can view, comment, or edit using the dropdown menu. 

 



LIBRARY AND LEARNING SERVICES STUDY GUIDE | GOOGLE DOCS 
www.2.eit.ac.nz/library/OnlineGuides/Google Docs.pdf 

 

 
 

If you click on advanced, this menu will appear, where you can change the privacy of the document and 
adjust the owner settings. 

 
Accessing 
You can change the access of the document by clicking on the drop down menu. 

 
 



LIBRARY AND LEARNING SERVICES STUDY GUIDE | GOOGLE DOCS 
www.2.eit.ac.nz/library/OnlineGuides/Google Docs.pdf 

 

 
 

Naming and Moving your Doc 
Naming 
Click on the current name of the document 

 
 
Type in the name you wish to change it to 

 
Click out of the box to complete the change. 
 
Moving 
Click the file icon next to the doc name.  
This will bring up a list of your folders in your Google Drive.  
Click on the one you wish to move it to and click on move. 

 
 
 
 



Google Sheets - Step by Step Guide

Objectives:

● Learn how to CREATE, EDIT, PRINT and ACCESS a Google Document

Timeline to Complete: Approximately 15 - 20 minutes

Create a New Document:
1. To create a new Google Sheet make sure you are

logged into your Google Drive. Then in the upper left

hand corner click on New and select Google Sheets.

A new Google Sheet appears in your browser and now

you're ready to edit.

Rename your New Document:

2. After creating a new sheet it is important to give

the spreadsheet a name. In the upper right hand

corner click on Untitled Spreadsheet.

You can rename your spreadsheet at any time by clicking the on title.

*This work was created by Staff Members of Indian Prairie School District 204



Enter the name of your spreadsheet in the text

box provided and click OK.

Edit and Format a Document:
3. Now it’s time to type and design your Google Sheet. There are many different tools and

ways to edit your spreadsheet with the edit toolbar.

A: You can use the toolbar menu options to edit and modify your spreadsheet in various

ways. Click a menu and then select the desired action from the drop-down list.

B: This toolbar provides convenient shortcut buttons for formatting the data in your

spreadsheet, like font size, text alignment, text color, and more.

C: Cell - Each rectangle in a spreadsheet is called a cell. A cell is the intersection of a row and

a column. A cell is where you will enter in text and format as desired.

D: Formula Bar - You can use the formula bar to

enter and edit data, functions and formulas for a

specific cell. In this example, cell B2 is selected.

Note how the data appears in both the cell and

the formula bar.

*This work was created by Staff Members of Indian Prairie School District 204



E: Sheets Toolbar- Every spreadsheet can have

multiple sheets. Select the sheet tabs to navigate

between sheets or click the Add Sheet + command

to add a new sheet.

You can rename a Sheet by double clicking on the Sheet # tab.

F: COMMENT FEATURE - In a Google Spreadsheet you can only comment on

a single cell at one time. To make a comment click on the cell and then

either click on the comment icon on the toolbar or the comment button on

the right hand corner.

If a cell has a comment then the corner of the

cell turns orange.

Many of the editing and formatting features in Microsoft Excel can be found in a Google

Spreadsheet.

Accessing Google Sheets:
Whether you are finished editing your spreadsheet or you want to finish it later,

there is NO NEED TO SAVE because Google Sheets automatically saves any changes for you.

So to exit you can simply close the window when finished or PRINT if necessary.

To PRINT your spreadsheet, click File > Print, or click the printer icon. A PDF version of your

document will appear with these print options:

*This work was created by Staff Members of Indian Prairie School District 204



There are 3 very important print options:

1. Current Sheet - This option will ONLY print the

sheet that is currently being viewed

2. All Sheets - Will print all pages

3. Selection - If you choose to print a selection, the

printed selection is the range of cells you selected

before opening the 'Print settings' dialog.

After choosing all your printing options simply hit print!

Your Google Spreadsheet can be accessed from your Google Drive. It is located in yourmy

Drive OR in a folder where it was created.

*This work was created by Staff Members of Indian Prairie School District 204



Explore with Google Sheets
The Explore function of sheets will be particularly helpful for individuals who don't consider

themselves to be "spreadsheet people." If you aren't comfortable running formulas and

functions, use the Explore feature. Click on Explore in the lower right corner and type in a

question and Google's machine learning engine will attempt to answer it for you.

Extra Resources:

● List of all Google Sheet Formulas/Functions:

https://support.google.com/docs/table/25273?hl=en

● Google Sheets: Getting Started- http://www.gcflearnfree.org/googlespreadsheets/8

*This work was created by Staff Members of Indian Prairie School District 204
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Google Docs: Spreadsheet basics

 
Once you know the basics on how to access, create, and edit Google Docs, read here to learn the 
basics that apply specifically to Google Docs spreadsheets.

Create a spreadsheet
From Google Drive (or your Docs list if Drive is not yet enabled), click the Create button and select 
Spreadsheet.
 

 
Tip: Don’t forget to rename your new spreadsheet. To do so, just click the name (which should be “Untitled 
spreadsheet” at this point).

Format data in your spreadsheet
To enter text or data in your spreadsheet, just click a cell and start typing. By default, data is entered in “Normal” 
format, which means no special formats are used - what you type is what you get.
 
Use the menus and toolbar to format the selected cells in your spreadsheet.
 

 
You can format your data as currency, percent, dates, times, plain text (where numbers are treated as text 
instead of numerical values to be interpreted), or other formatting options:
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Work with rows, columns, and sheets
The building blocks of a spreadsheet are rows and columns of cells filled with data. Each grid of rows and 
columns is an individual sheet.

Add a row or column
1. Select any cell that should be next to the new row or column.
2. On the menu bar, click Insert and then choose where to add your row or column.
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Tip: To add multiple rows or columns at one time, first select the number of rows or columns you want 
to add. The Insert menu will then give you the option to add that many rows or columns. For example, if 
you select a block of 2 columns by 3 rows, the Insert menu shows these options:

 

Delete a row or column
1. Select one or more cells in the row or column you want to delete. If you select multiple cells, you can 

delete multiple rows or columns at a time.
 

2. On the menu bar, click Edit and then choose which rows or columns to delete. For example, if you 
selected rows 4, 5, and 6 in column C, you’ll see these options:
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Tip: If you only want to delete the data in the cells (but still keep all the existing rows and columns), 
select Delete values.

 

Move a row or column
You can use Copy and Paste (on the Edit or right-click) menu to move cells, but here’s a quicker way:
 

1. Select the cell or block of cells that you want to move.
2. Move your cursor to the edge of the selected cells, until you see the cursor change into a hand:

 
3. Hold down the mouse button and drag the cells to their new location.

 
4. Release the mouse button to drop the cells in their new location.

 

Keep header rows and columns in place
Your first rows or columns might be headers that you want to always keep at the top or left as you scroll through 
your spreadsheet. In that case, you’ll want to freeze the first rows and columns so they stay put. You can freeze 
up to 10 rows and 5 columns.
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Just click View > Freeze rows (or View > Freeze columns), and then select the number of rows to freeze. 
 
 
In the example below, the top 2 rows are frozen. You can tell by the thicker line beneath Row 2:
 

Tip: You can also drag and drop the blue line sections to quickly change the number of frozen rows or columns.
 
Once frozen, your headers will stay in place as you move about your spreadsheet, and they won’t be sorted if you 
sort a column.

Add a new sheet
You might have multiple spreadsheets for a given project. For example, a travel company planning a tour might 
create separate spreadsheets for tour dates, customers, transportation, hotels, excursions, and so on.
 
A convenient way to handle multiple related spreadsheets is to use Google Docs “sheets.” Sheets let you open 
one Google Spreadsheet and quickly jump back and forth between the related sheets, similar to how you might 
use tabs in a browser to jump between different web sites.
 
To add a new sheet:
 

1. Click the plus sign at the bottom left of your spreadsheet:

 
2. By default, sheets are named Sheet1, Sheet2, Sheet3 and so on, so you’ll probably want to rename the 

new sheet. Select the tab for the new sheet, click the drop-down arrow, and select Rename:
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Tip: The quickest way to re-order sheets is to drag and drop the tabs.

Get started with functions
Functions make calculations easy and automatic. Access functions from the summation sign on the Edit toolbar 
(alternatively, click Insert > Functions from the menu toolbar). You'll have immediate access to some of the 
most common formulas like Sum and Average. To learn about these functions, plus all the additional formulas 
that you can use, click More functions.
 

 
To use the data from other cells in your functions, refer to the cells by column number followed by row number 
(A6, C2, and so on). For example, here’s how to use the SUM function to add the cells directly above it:
 

1. Select the cell to contain the sum.
2. Click the function button (the summation sign) and select SUM.
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3. The SUM function is inserted in the cell:

4. Select the range of cells you want to add. The cell range (D2 to D5 in this example) is added to your SUM 
function:

 
5. Press Enter or Tab to see your result:

 

Share and collaborate
Take advantage of the collaborative features of Google Spreadsheets by sharing your spreadsheet with others. 
Multiple people will be able to edit the same spreadsheet at the same time -- you'll always have the most up-to-
date version at your fingertips.
 
To get started sharing a spreadsheet, click the Share button at the top right of the page. See Google Docs 
Sharing and Collaboration to learn more about sharing settings.
 
There are a couple differences about collaborating in spreadsheets compared to text documents: only one person 
can edit a cell at any given time, and comments are stored with individual cells. These differences are described 
below.

Collaborate with joint edits
A cell that you’ve selected is outlined in blue, but when someone else is editing your spreadsheet, a cell they've 
selected has a different color border. If you want to see who has selected a cell, just move your mouse there:
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With Google Spreadsheets, you don't have to worry about overriding edits made by someone else. A cell will be 
greyed out while it’s being modified by someone else:
 

 
If you try to edit a greyed out cell, your changes won’t stick.

Collaborate with comments
If you can edit a spreadsheet you can add comments to individual cells:
 

1. Select the cell you want to comment on.
2. Click Insert > Comment (or use the right-click menu).
3. Type your comment. It will automatically be “signed” with your name and date:

 
 

4. Click into another cell. You’ll see that the cell you commented on now has an orange triangle in the 
upper-right corner to indicate comments:

 
5. If you want to add another comment, follow the steps above. New comments for a cell are added above 

the older comments.
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6. To see comments, just hover over the cell:

 
7. When you’re done with comments for a cell and want to remove them, right-click over the cell and select 

Clear comments.
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LESSON 8 

Google Slides Tutorial 
 

 

Google Slides is a powerful tool for presentations. It helps you prepare 

convincing and attractive presentations for your audience and adds emphasis 

to what you’re trying to convey. To learn more about Google Slides, check out 

this link: 

https://www.google.com/slides/about/ 

 

With that brief introduction out of the way, let’s get started! 

 

● Opening slides: 

 
1. Select the “Google Apps” button and then “Slides” 

 

 

 

 

 

https://www.google.com/slides/about/


 
 

 

 

2. Since we’re just starting out, let’s work with a “Blank” template. 

 

 

 

 

 



 
 

 

● Naming slides: 
 

1. Place your cursor in the textbox as indicated. 

 

 

 

 

2. Type in the name you wish to give the presentation and press ENTER. 

 

 

 

 

 



 
 

 

3. You can choose from several themes. In the picture below, the “Simple 

Light” theme has been chosen. 

 

 

 

 

 

 

● Adding content to slides: 
 

Adding text is very easy. All you have to do is click on the textbox and start 

typing. 

Once you’re done, place your cursor in the next text box or click anywhere on 

the screen. 

 

 

 

 

 

 

 



 
 

 

 

 

 

 

 

 

  

 

● New Slides: 
 

There are two ways to add a new slide to your presentation: 

 

1. Select the ‘Insert’ button, and click on ‘New Slide’ 

 

 

 



 
 

 

 

 

 

2. Select the ‘Slide’ button, and click on ‘New Slide’ 

 

 

 

 

 

 



 
 

 

● Formatting: 
 

Now that we’ve typed out our text, let’s try and make it look better! 

 

1. To do that, select the “More” button next to font size. 

 
 

 
 

 

2. You now have several options to choose from: 

 

 

 

 

 



 
 

 

a. “Bold”, “Italics” and “Underline” are used to darken, italicize and 

underline the selected text. 

 

b. “Text Colour” and “Highlight colour” allows us to change the colour and 

highlight the selected text. 

 

c. “Insert Link” allows you to insert a hyperlink( the address you had typed 

in the search bar earlier) into the document: 

i. Select the necessary text you want to attach a link to. 

ii. Select “Insert Link”.  

iii.Copy and paste the web address you wish to link the text to in the 

“Link” tab. 

iv. Alternatively, you could directly select “Insert Link” and type in the 

text in the Text Box given and then link the same text in the “Link” tab. 

 

d. “Add Comment” allows you to add comments to the selected text: 

i. Select the necessary text you want to add a comment to. 

ii. Select “Add Comment” 

iii.  Note: The comments will only be visible to the people you have 

shared the presentation with and have “edit” or “Comment” access. 

(To be covered in a bit). 

 

e. “Line Spacing” allows you to adjust between two lines or paragraphs.  

i. Select the desired sentences or paragraphs  

ii. Select “Line Spacing” 

iii. Choose the distance between the lines 

 

f. Lists allow you to organize your information into concise points:  

i. “Numbered list” organizes your information in the form of numbered 

points. 

ii. “Bulleted list” organizes your information in the form of bulleted 

points. 

 



 
 

 

iii. To create a list, just select either of the options and begin typing, 

press “ENTER” to move to the next point. 

iv. Alternatively, you could type out your information first and then 

select the group of sentences and click on either of the list buttons. 

 

g. “Increase Indent” allows you to adjust the indentation of the slide. 

 

 

● Changing the background: 
 

Changing the default background of your presentation to make it visually 

appealing is very important. To do so, 

 

1. Select the ‘Slide’ button, and then click on ‘Change Background’ 

 

 

 

2. Now, you can select your desired colour, or you can upload an image to 

use as the background. 

 



 
 

 

 

3. Once you have made your selection, click on ‘Done’. The changes will be 

reflected in the presentation. 

 

 

● Applying a layout: 
 

To change the layout of your presentation, the following steps are to be 

followed: 

1. Select the ‘Slide’ button, and then click on ‘ Apply a layout’ 

 

 

 



 
 

 

2. As you can see, there are several layout selections that can be made. 

 

3. Click on the layout you want to use, and the presentation will be 

updated accordingly. 

 

 

● Changing the theme: 
 

The default theme may be a little bland for some people. To change that, 

 

1. Select the ‘Slide’ button, and then click on ‘Change Theme’ 

 

 

 

 

 

2. A ‘Themes’ tab pops up on the right with several options to choose 

from 

 

 

 

 

 

 

 



 
 

 

 

 

 

3. Select the theme you like, and the presentation will update 

automatically. 

 

 

● Applying transitions: 
 

Transitions are an important part of a presentation. They make it more fun 

and interactive.  

To apply transitions to slides, or objects in your presentation, 

 

 

1. Select the ‘Slide’ button, and then click on ‘ Transitions’ 

 

 

 

 

 

 

 

 



 
 

 

 

 

 

 

 

2. A ‘Motions’ tab pops up on the right.  

 

 



 
 

 

 

 

3. To add/edit the transition between slides, under the ‘Slide Transition’ 

heading, select the transition you desire. You can also choose to apply that 

transition to all the slides in the presentation. 

 

 

 



 
 

 

 

4. To add/edit the transitions of objects, like text or images in the slide, 

select the image or text in question, and choose the transition that you desire 

under ‘ Object Animation’ of the ‘Motion’ tab. There are several options to 

choose from, including the type of transition, and when you want it to start. 

 

 

 

 

 

 

 

 

 

 

5. Once you have made the selections, the changes will be updated 

automatically. You can also review the transitions by clicking on ‘Play’. 

 

 

 



 
 

● Adding Images: 
 

Visual aid is an important part of every presentation. To add images to your 

presentation, 

 

1. Select the ‘Insert’ button, and then click on ‘Images’ 

 

 

 

 

 

 

 

 

 

 

2. There is a choice of either uploading the image from the computer or 

from the web. 

 

3. Once you have selected the image, the image will be placed on the 

slide. Its position can be changed by selecting the image with the cursor and 

moving it to the desired location. 

 

 



 
 

 

 

 

 

● Adding Videos: 
 

To add videos to the presentation, 

 

1. Select the ‘Insert’ button, and then click on ‘Video’ 

 

 



 
 

 

 

 

2. Now, the video can be selected by searching in the search bar provided, 

or by pasting the URL of the YouTube video you wish to add to the 

presentation 

 

 

 

 

 

 

 

 



 
 

 

 

3. Here, I have searched for “Bits Pilani’, and the following options were 

displayed. 

 

4. Select the video you wish to add, and click ‘Select’. The video will now 

be placed in the presentation.  

 

5. There are several options available for formatting - You can  

 

a. Change the Video playback time, or mute audio 

b. Change the size and position of the video 

c. Add shadows 

 

 

 

 

 

 

 



 
 

 

 

 

       6. Once you have made the required changes, it will be updated in the 

presentation. 

 

 

● Adding audio: 
 

To add audio to the presentation, first the audio file must be in your Google 

Drive 

 

1. Select the ‘Insert’ button, and then click on ‘Audio’ 

 

 

 

 

 

 

 

 



 
 

 

 

 

2. Choose the audio file from your Google Drive 

 

 

 

 

 

 



 
 

● Adding Shapes 
 

To make the presentation more interesting, shapes can be added. 

 

1. Select the ‘Insert’ button, and then click on ‘Shape’ 

 

2. There are several options to choose from. Select the shape you want, 

and it will be pasted in the presentation, where its shape and position can be 

changed. 

 

 

 

 

● Adding Diagrams: 
 

Several technical presentations require the use of Diagrams. To add them, 

 

1. Select the ‘Insert’ button, and then click on ‘Diagram’ 

 

 

 



 
 

 

 

2. A ‘Diagram’ tab pops up on the right, with several diagram options. 

Select the diagram you desire, and it will be pasted in the presentation. 

 

 

 

 

 



 
 

Our Presentation is now ready, let’s focus on the few presenting applications 

of Google Slides. 

 

● Presenting the presentation: 

 
1. On the top right hand corner, click Present. For best results, present 

with Google Chrome. 

 

2. From the current slide, the presentation will now become a full screen. 

  

3. The tools available while presenting are: 

o Live Q&A: Presenters can start a live Q&A session with an audience 

during a presentation with Google Slides. You can present questions 

at any time, and people can ask questions from any device. 

 

 

 



 
 

o Notes: To view the Speaker Notes ( Addition of speaker notes is 

covered next) 

 

o Pointer: If you prefer presenting from a computer, Google has a new 

laser pointer feature that overlays a red dot with a trailing line, just 

like a real laser pointer following your cursor 

 

o Captions: The closed captions feature is available when presenting in 

Google Slides. It uses your computer's microphone to detect your 

spoken presentation, then transcribes—in real time—what you say 

as captions on the slides you're presenting. 

 

 

     5. ​To exit full-screen, press the Esc key. 

 

 

 



 
 

● Speaker Notes: 

 
Speaker notes are short summary points to the slides which the presenter can 

refer to while delivering the presentation. 

 

1. We simply enter the text in the textbox named “ Click to add Speaker 

Notes” below our slide. 

 

 

 

2. In the top right corner, next to "Present," click the Down arrow. 

 

3. Click Presenter view. 

 

 

 

 

 



 
 
 

 

 

4. Click Speaker notes. 

 

 

 



 
 

 

 

● Sharing The presentations: 

 
1. Select the “Share” button. 

 

 

 

2. Type in the email IDs of people you want to share it to. 

 

3. Next, it’s time to decide the level of access to grant: 

 

a. Viewer: Only allowed to view the document and not make 

changes or  add comments. 

b. Commenter: Allowed to add comments to the document but 

not make changes. 

c. Editor: Allowed to make changes and add comments. 

 

 

 



 
 
 

 

 

 

 

4. Apart from adding the names of people manually, you can also create a 

link to the presentation by clicking on “​Copy Link​”. Here as well, you get an 

option of the mode of sharing - Editor, Commentor and viewer. Apart from 

that, you also have an option to keep the access restricted to the people you  

 

 



 
 

 

have named above, people in your organisation or open for all with the link. 

This link can then be shared in the relevant groups. 

 

 

 

5. Once you’re done, hit “Send”. 

 

6. Bonus: If you want to send a message along with the document, type it 

in the message box.  

 

● Downloading the presentation: 

 
1. On the top left hand side corner of the document, select “ File” and 

select “Download as”. 

 

2. Choose a file type. The file will download onto your computer. 

 

 

 



 
 

 

a. .ppt​: ​is a filename extension for downloading the sheet in Microsoft 

Powerpoint format. 

 

b. .pdf: ​PDF stands for "portable document format". Essentially, the 

format is used when you need to save files that cannot be modified but still 

need to be easily shared and printed. 

 

 

 

 

Great! Let's head to the next one! 
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Google Forms 
Opening a New Form  
To open a new Google Form, navigate to your Google Drive and click on New. 

 
Click on More 
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Click on the arrow next to Google Forms 

 
 
Choose between whether you want a blank form or a template 

  
 
If you choose Template, it will bring up a list of templates that are designed for specific types of forms. 
Click on the one you wish to use. 
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If you choose Blank, it will open up a document that looks like this. 

 
Creating a Form 
Name and Description 
To begin creating the content of the form, you should first give the form a name and description. Click in 
the box that say Untitled Form.  

  
Enter the new name. 
Then, click in the box that says Form Description and enter a relevant description and any relevant 
instructions for those filling out the survey. 
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Questions 
There should be a question box directly below the Name and Description. 

 
First, type the question in the Untitled Question box 

 
Then, using the dropdown menu to the right of the question, select the format of the question e.g. 
Multiple choice, short answer, file upload etc. 

  
 
 
 
 
 
 
 
 
 
  
 
 
If you were to choose an option like Multiple Choice or Checkboxes, you then need to go through and 
create the options. Click on Add Option to type one or on Add Other to automatically add an Other 
option. 
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Once you have created the question, you can then use the menu at the bottom to either copy it, delete 
it, make it a compulsory question in the form. 

 
If you click the  icon in the bottom right-hand corner, you are then given the options to add a 
Description, redicrect the user based on their answer, or to randomly shuffle the option order. 

 
Adding Questions and Media 
Use the toolbar at the side of the form to add another question. From this toolbar, you can also add 
pictures and videos. Or you can add sections to divide the form into separate sections, 

 
 
Customising your Form 
To change the look of the form, click on the paint palette icon at the top of the page.  
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You can then change the font and colours, as well as add a header image. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Collecting Responses 
Click on the responses tab at the top of the page. 

 
Make sure that the switch is set to Accepting Responses 

 
if you click the  icon, you can decide where the responses go. You can have them emailed to you, 
downloaded, or sent to a response destination. 
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For the response destination, you can choose between a Create a New Spreadsheet or Select Existing 
Spreadsheet. The responses will then be compiled within that. 

 
Customising Form Settings 
If you click the Settings  icon in the top right-hand corner, you can them determine factors relating 
to your form, such as whether people can submit the form multiple times,  

 
 
 
 
 
 
 
 
 



LIBRARY AND LEARNING SERVICES STUDY GUIDE | 
www.2.eit.ac.nz/library/OnlineGuides/.pdf 

 

 
 

How the form presents itself, 

 
or whether it is a quiz that needs to be graded 

 
Once you have selected your preferred settings, remember to click on Save. 
 
Sending the Form 
Once you have created the form, you can then send to people that you wish to participate in it. Press 
the Send button in the top right-hand corner, and then enter their email addresses. 
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About  
Google forms is a free Google application that allows you to quickly create and distribute a form to gather 
information. Form responses are saved in a Google spreadsheet in Google drive.  

Opening Google Forms 
Step 1. Open Google Chrome.  
Step 2. Go to http://drive.google.com 
Step 3. Enter your full UWW email address, then click next.  
Step 4. Enter your UWW password, then click Sign in.  
 
You will now be signed into Google Drive.  
 
Step 5. Select New > More > Google Forms from the available menu. Choose either a Blank form or From a 

template. 

 

 

http://drive.google.com/


                                                                              

 
4 

 

Editing Google Forms 

Creating a New Form from Template or by using a Blank form 

Step 1. The Template gallery General tab offers a 
number of form templates. Or, simply click on 
Blank form to start from scratch. 

 

 

Editing your form 

Step 1. Name the Form. Click the “Untitled Form” 
name in the top left corner of the screen, 
then enter the form’s name. Hit the “Enter” 
key to submit your changes. If using a 
template, click on the template title to 
change to a unique name of your choosing. 

 
 
 
 
 
 
 
 
 
 
Step 2. Form description: Enter the description by 

clicking on that field. When using a template, 
you may find stock text in this field. Highlight 
and delete to replace with your description. 
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Edit Questions 

Step 1. Select “Untitled question” to enter your first 
question text.  

Step 2. Use the dropdown to the right of the question 
to select the question type.  

 
 

Step 3. Select each option to enter option text.  
Step 4. Hit the “Enter” key to create a new option.  
 
Note: Click the X to the right of each option to delete 
that option.  
 
Note: Click the Add Other link to add an “Other” 
option to your list.  
 

 

 

Add Questions 

Step 1. Use the question toolbar to the right to add a 
new question, insert a new title and 
description, inset a picture, insert a video, or 
add a new section.  

Step 2. Follow the steps above to edit the new 
question.  
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Copy/Duplicate Question 

Copying a question allows you to quickly add a new 
question with the same format as your current 
question. 

 
 

 

Delete Questions 

The delete button allows you to delete the selected 
question and options from the list.  

 
 

 

Required Questions 

Select the “Required” button to make a question 
required.   
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More Button 

The         (More) button allows you to shuffle the 
order of questions and go to a new section based on 
a question answer.  

 
 

 

Form Colors/Themes 

You can change the form color or theme by clicking 
the         (Color Palate) button in the top right corner 
of the page.   
 
Click the          button to select a header image on a 
theme or upload your own.  

 
 

Preview Form 

 Click the “Preview” button to open a new browser 
tab with a final view of your form. Close out of that 
tab to return to the “Edit Form” view to make 
changes.  
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Advanced Form Settings 

Click the         (Settings) button to 
customize your form.  
  

General Tab: Allows you to 
restrict users from your form, 
collect email addresses of users 
filling out your form, limit 1 
response, etc.  

 
 

Presentation Tab: Allows you to 
display a progress bar, shuffle 
question order, and submit 
another form response. You can 
also modify your confirmation 
message once a user submits a 
form.  
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Quizzes: Allows you to set this 
form as a quiz, set grade options, 
etc.  
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Send Form 

Click the Send button to view different ways 
to distribute your form.   

 

Send Via Email: You can send your form via 
email to recipients or send the form email 
to yourself, then use Outlook to forward the 
form link to others.  

 
 

Copy Form Link: Click the “link” icon to 
display the Form’s URL link. Select the 
Shorten URL option to display a short link 
option.  
 
Click the Copy link in the bottom right to 
copy the link.  
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Social Media: Click any one of the social 
media icons to share the form link using a 
social media platform.  

 

Viewing Responses 

 
 Click the Responses tab to view user responses to 
your form.  

 
 

Summary: Shows a pie chart percentage of 
responses for each question.  
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Individual: Displays each form response individually. 
Click the < or > button to move between each 
response.  

 
 

Spreadsheet View: Click the        (Create 
Spreadsheet) icon to create and view form responses 
in Google Sheets. Select to create a new spreadsheet 
or add to an existing spreadsheet.  
 
Once a spreadsheet is created, click the        again to 
open the spreadsheet.  
 
Note: If you wish to be notified of any new form 
submissions, select Tools > Notification Rules from 
the Google Sheet menu. Select your notification 
preference, then click Save to save your changes.  
 
Note: Do not modify the sheetsheet data until after 
you have collected all responses. Modifying the form 
could result in incorrect data placement.  

 

 

Close Form 

 You can close the form for submission by selecting 
the Responses tab, then clicking the Accepting 
Responses toggle.  You can modify the message 
respondants will see if they try to access your form 
while it is closed. Click the toggle again to reopen 
your form.  
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View Form and Form Responses is Google Drive 

To edit your form or view your form response 
spreadsheet, go to Google Drivem then select your 
form. Use the search box at the top of the page to 
find your form if the form was saved in a folder.   

 
 

Delete Form 

To delete your form completely, locate your form in 
Google drive, right click on the form name, then 
select Delete. You may also delete the form 
responses by following the same steps.  
 
Note: Use the search box at the top of the page to 
locate your form if you cannot find it on your main 
Google drive page.    

 
 

Troubleshooting 
For additional help using Google forms, please email training@uww.edu. 
  
 

mailto:training@uww.edu
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